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Overview 

This document covers the new features introduced in the 2014 Release of Impact.  Many of these 
features can be utilised out-of-the-box; however, several may require configuration changes, i.e., where 
an existing installation is to be upgraded.  Such features are identified throughout this document by an 
asterisk (*).  Certain features were introduced towards the end of the Impact 2010 life-cycle.  Such 
features are identified throughout this document by twin asterisks (**).  Not all of the features 
described within this document are applicable to all Impact licenses.  Please consult Arden Software for 
further details. 
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3D Animation 

Simple Animation Editor Mode 

 
The Animation Editor may now be switched between Simple and Advanced modes (Simple is the default 
for Impact 2014).  Advanced mode displays a channel for each folding face of a model – as with previous 
Impact versions. 
 

 

Fig 1 – Animation Editor in Advanced Mode 

 
 
Simple mode allows a single key-frame to represent all folding key-frames for a single model.  This 
speeds up the animation process as the animator no longer needs to repeatedly select all folding faces 
(in the 3D Fold Standard Toolbox), before recording a face-folding key-frame.  An additional benefit is 
that it also simplifies the time-line to show a reduced number of channels (and hence key-frames). 
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Fig 2 – Animation Editor in Simple Mode 

 

Always use straight paths by default 

In previous Impact versions, animated objects (folding models, mesh objects etc.) travelled along curved 
paths by default.  When aligning multiple parts, this often resulted in an over steer effect which needed 
to be corrected via the Entity Inspector (the Path and Rotation options allow a choice of curves, Beziers 
or straight lines). 
 
 

  

Fig 3 – Impact 2013 & earlier created curved paths by default 
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 For the release of Impact 2014, the default behaviour of animated objects will be to move along straight 
paths.  If curved or Bezier paths are required, changing the Path and Rotation options within the Entity 
Inspector will modify the object paths. 
 

  
 

Fig 4 – Impact 2014 creates straight paths by default 

Cut/Copy/Paste a range of key frames  

A common animation requirement is the possibility to re-use key frames, in order to repeat the 
movement, rotation or face-folding of an object.  In previous versions, it’s been possible to copy a single 
key frame (right-click>copy) or an entire frame of key frames (shift + copy).  In Impact 2014, it is now 
possible to Cut/Copy/Paste a range of key frames and to paste them into a different position on the 
time-line.  Simply click & drag to define the start & end key frames and right-click to display a context 
menu featuring Cut/Copy & Paste options.   Note that the key frames must be visible (their containing 
nodes must be expanded), if they are to be Cut/Copied/Pasted! 
 
 

 

Fig 5 – Select/Copy a range of animation key frames 
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Reverse Animation (Mirror Key Frames) 

Another common animation requirement is that of folding a model from flat and then returning it to a 
flat state.  In previous Impact versions, the animator would have had to either animate the folding & 
flattening process manually or copy & paste multiple key frames along the time-line (as mentioned 
previously). 
 
In Impact 2014, it is now possible to copy a range of key frames within the animation editor, paste them 
onto the time-line (as above) and then to mirror them.  The Mirror option is available from the context 
menu (along with the Cut/Copy/Paste options mentioned previously). This represents a significant time-
saving as the actual folding-from-flat key frames can simply be reversed to create the unfolding 
animation.  A useful by-product is that this allows the simple creation of looped animations. 
 

 

Fig 6 – Pasting a range of animation key frames 
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Fig 7 – Mirroring a range of animation key frames 

Furthermore, in certain circumstances, it may be quicker to assemble a multi-part model and to animate 
the disassembly of the model to create an animation.  As above, in previous versions, this would have 
taken a considerable amount of time to manually rearrange the key frames upon the time-line.  In 
Impact 2014, the ability to mirror the key frames represents a major simplification.  Simply assemble the 
model into a single piece, animate the disassembly and mirror the animation. 

Go to frame/Jump to frame (Previous/Next) 

To guarantee a well-paced animation, a common tip is to space animation events (faces folding, object 
movements etc.) apart by an identical number of key frames (animate every 10 or 20 frames, for 
example).   This does require lots of interaction with the time-line, which can be quite time-consuming.  
As a result, two new Animation Editor controls have been added in order to speed up the animation 
process.  Go to Frame allows the animator to enter the frame number they wish to move to and click 
Return/Enter – this is significantly quicker than manually clicking upon the time-line. 
 
Jump to Frame allows the animator to quickly jump to the next-recorded (or previously recorded) key 
frame (again, without clicking on the time-line).  As an example, this is especially useful for 
retrospectively adding camera frames to a folding/moving animation.  You’d wish to check the camera 
positions at each fold or move/rotate event.  The jump to frame option facilitates this without 
interacting with the time-line at all. 
 

 
 

Fig 8 – Go to Frame and Jump to Previous/Next Frame controls  
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Note that it’s possible to assign keyboard shortcuts to Jump to Frame (Next & Previous) tools, to further 
speed up the process. The command names are 3D Animation Next Key and 3D Animation Previous Key. 

3D Import & Export 

Collada 3D Export/Autocad DWG 3D Export * 

Augmented Reality has become fairly well-established over the past few years.  The Collada 3D file 
format is widely supported by many Augmented Reality solutions and Impact is now able to export 3D 
scenes in this format.  Textures (and Artwork) are both supported whilst lighting and camera support is 
also provided. Impact provides two Collada export options – a *.dae export and a *.zae export.  The 
former will export textures textures/artwork and the model separately, whilst the latter will effectively 
package the model & textures/artwork in a single zipped file.  At the moment, Impact will only export 
static models to the Collada format.   
 

 

Fig 9 – COLLADA 3D Export Settings 

As above, this format is widely used by Augmented Reality applications.  The same functionality listed 
for the Collada format export is applicable to the DWG format.  Note that the 3D Autocad DWG export 
also allows for a choice of *.DWG formats: 
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Fig 10 – Autocad DWG 3D Export Settings 

 

 
 

Fig 11 –Export 3D Scene Dialog offering Autocad Drawing (*.dwg) and COLLADA (*.dae and *.zae) exports 
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3DX Library Update (Requires Version 1.4 of the 3DX Module)* 

The HOOPS Exchange library (used for the Impact 3DX module) has been updated (to version 6.10) , 
which adds support for RHINO 4 and RHINO 5 file formats as well as providing updated support for  the 
following formats: 
 

Format:    Version: 
Autodesk Inventor   2014 
Creo Parametric   2.0 
CATIA V5    V5-6R2013 
CATIA V6    2013 
Solid Edge    ST5 
SolidWorks    2013 
Siemens PLM NX Software  8.5 
ACIS     Up to version 23 

  

 
 

Fig 12 – 3DX Import dialog showing the additional Rhino (*.3dm) format support 

Reduced 3D PDF File Size – Image & Texture Compression for 3D PDF/U3D 
Exports* 

Significant reductions in 3D file sizes can be achieved via new compression options for PDF and U3D file 
exports.  Compress Textures in 3D Layer has been added to the Adobe Acrobat branch of the Non-Native 
Export node (Options> Master Tool Settings> General Tools > Import/Export Settings).   
Following an Impact upgrade, this option will be switched off by default.   
 
For consistency, the equivalent 2D tool (previous known as Use Image Compression) has been renamed 
to Compress Images in 2D Layer.  During an Impact upgrade, the status of this option will  
remain unchanged. 
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Fig 13 – Texture Compression for 3D PDF Exports 

 
 
 

 
 

Fig 14 – Texture Compression for U3D Exports 

Automation 

Include Scripts 

It is now possible to include other scripts (either from files or stored in the database), into your scripts 
using include directives. This way you can build up libraries of commonly used subroutines, avoiding 
duplication of your code. 

Improved Plugin/COM Deployment (Impact Auto Plugins) 

Traditionally, distributing macros, scripts and COM plugins has been quite a labour-intensive task, 
involving setting common file repositories, distributing custom icons and potentially updating many 
Appearance Settings. Over a large installation, this can be especially time-consuming.  IAPs allow a 
macro/script/plugin to be packaged (complete with an icon, if required) for quick deployment, with 
minimal effort required for the Impact Administrator 
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Fig 15 - Custom menu item (on a menu or toolbar), linked to a script. 

Fig 16 – Distribute option via Customise mode 

 

Fig 18 – Save and distribute the IAP to 
destination workstation(s) 

 

Fig 17 – Author the IAP  
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Modifications to AutoTask Settings 

 
 
 

        
 

Fig 19 – IAP added to Plugins menu on 
destination workstation(s) upon login 

 

Fig 20 – IAP can be added to any menu, 
context menu or toolbar on destination 
workstation(s) 

 

The term Macros is outdated and has 
often been misused.  As a result, the 
Macros menu item has been replaced by 
Automation.   
 
Many of the Impact auto-tasks (now 
found within Database 
Installation>Automation) have been re-
named to provide a clearer description of 
what the tasks actually do (as an example, 
LayoutAddSheet becomes Layout Add 
Sheet Size and Symbol).   
 
The button for assigning an automation 
item to a task has been removed - simply 
double-click the task in order to assign an 
Automation item to that task.   
 
Autotask scripts may now be stored inside 
the database (as opposed to referencing 
files) and several new auto-task triggers 
have been added (especially for the 
Diemaking tools).  Some examples of the 
new Impact 2014 triggers are presented 
on the left. 
 

Fig 21 – Additional Auto-Task Triggers 
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Programming Interfaces 

More than 150 new objects, methods and properties have been added to Impact's COM interface, 
allowing even more powerful scripts and plug-ins to be written. The new interfaces provide: additional 
entity properties and palette properties; improved traversal though the block hierarchy; new entity 
comparison and copying; improved hatching, hole-finding and path-finding; improved entity picking and 
transformations; the ability for a script to call another script or macro. In addition, one of the most 
powerful new features is the ability to easily create and manipulate closed shapes, using IShape objects, 
with methods for offsetting, uniting, intersecting, masking/clipping, to name just a few. All the Impact 
COM interfaces are described in the Impact COM Documentation, available on request. 

Databases 

LDAP support for Impact (Logging on to Impact using your network credentials)* 

If your company uses a directory service such as Microsoft Active Directory or Novell edirectory for user 
authentication and authorization, you may now configure Impact to use it. This allows you or your 
system administrators to manage Impact user access in the same way that you manage access to other 
network resources. Impact simply uses LDAP (lightweight directory access protocol) to retrieve the 
user's attributes and thereby determine their privileges. Using this mechanism, users no longer need a 
separate username and password to connect to the Impact database.  
 

 

         Fig 22 – LDAP Authentication 
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Database – Projects 

User Privileges to prevent Project folder name changes* 

 
 

 Fig 23 – Folder Rename User Privilege 

 
 
 
 
 
 
 
 
 
 
 

New user privileges have been 
added to control the re-naming of 
Project, Symbol & Template 
folders.    
 
Previously, the Change Properties 
privileges (within 
Database>Folders) controlled 
access to the renaming of folders, 
however if a user created a folder, 
they could rename it without this 
privilege.   
 
The new privilege Rename may be 
found within the Project, Symbol & 
Template nodes of the Database > 
Folders branch. 
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Diemaking 

Rotary Split allows splits along user defined paths 

The split line (or path) separating the extents of the rotary dieboard into two or more shells can lie along 
any user-defined path, as well as the previously-supported construction lines. 
 

 

Fig 24 – Rotary Split 

Quick Rebridge tool – Remove All Bridges 

A new edit bar option (All bridges) has been added to the remove bridge mode of the Quick Rebridge 
tool.  This allows all bridges to be removed from a picked entity, along with the option of All Selected 
entities.  

 

  
 

Fig 25 – Remove All Bridges and Remove All Selected Bridges 

Option to offset a strip knife along the length of an entity/orthogonally   
 
The Stripping Knife tool has had several new placement modes added, as well as a new edit bar option.  
The type of strip knife being placed needs to be selected (gutter, internal knife, perimeter or perimeter 
slot), whilst the mode for gutter strip knife placement has been extended.  This mode now allows the 
position to be offset from another entity as well as offset from end point (along with the existing option 
of snapped point).  The offset from end mode has a new offset option (offset horizontal/vertical).  If 
enabled, the offset will be applied orthogonally (horizontal for 'angle vertical' and vertical otherwise). 
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Fig 26 – Offset Along Entity/Offset Orthogonal 

 

Stripper Creator  

Conditional placement of Dynamic Stripping Components 

To further extend the flexibility of the Dynamic Stripper Component master tool settings, a new option 
has been added to define if each male component is to be placed against a restriction (normal/point slot 
etc), when applied to an internal or perimeter waste area (or indeed both). 
 

 

Fig 27 – Stripping Component Conditional Placement 
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Conventional Stripper Male Waste - automatic placement of claws in slots 

 
The automatic placement of male components in a waste area now has the option to apply claws in slots 
areas. 
 

 
 

Fig 28 – Claw Placement 

 

Conventional Stripper option to contour with male knives/claws/pins and a 
wooden block  

The automatic placement of male components in a waste area can contour first with male 
knives/pins/claws and then create the wooden block.  
 

 

Fig 29 – Composite Contouring 
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Forced Slot / Remove Forced Slot 

To compliment Impact’s existing powerful Dynamic and Conventional stripping tools, Impact 2014 sees 
the introduction of further edit tools to hand the user even more control over the placement of internal 
and external slots.  The new Forced Slot/Remove Forced Slot development works in tandem with the 
Perimeter/Inside tools to allow quick and easy identification of slots not automatically placed by the 
Stripper Creator.  Once a slot is identified, the user has access to all Male Stripper Components allowing 
them to pick and choose how best to strip the chosen slot.  These new features fully support replication 
along with copy/paste options to avoid duplicate effort for the user.  

Slot Visibility* 

Similar to the Stripper Completion visibility in Impact 2013, a new Slot visibility option has been added, 
allowing the user to quickly identify parts of a stripper where the chosen setting detects an area too 
narrow for generating male components at the standard offset. The fill colour is customisable via the 
environment options so each individual user may choose their preferred colour combination. 
 

 

Fig 30 – Slot Visibility 

Blanker 

The blanker tool for 2014 has had several enhancements to support the creation of flat top blanking 
units as well as frame and bar separators.  
 

Visibility and shortcuts 

We have added new visibility controls to toggle the visibility of the male base and uppers as separate 
components.  To improve the workflow it is possible to add shortcut keys to standard functions such as 
– new (item), delete and select. 

Frame  

The offset from the frame to the design extents has default values for single and double cut layouts, 
allowing the offset allowance to be automatically calculated dependent upon the layout. 
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Fig 31 Frame Calculation 

 

Bars 

The lower frame bars have a centreline path defining the width properties for that bar, and when 
creating a bar section a bend radius is automatically applied.  
 

 

Fig 32 Bar Centreline and Bend Radius 

 
The editing of bar paths has similar options to other manufacturing tools (allowing points to be added 
along a path and repositioned). The end point of a bar can be modified allowing a bar to finish 
unattached to the frame or another bar allowing the bar to be secured to the flat top.  The symbol or 
component to attach the bar to the frame has been expanded, to allow different parts added to the 
side, front and back of the frame. 
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Joggers and frame component placement 

The components placed on the lower blanking unit can now be defined as frame, bar, grip, design or 
free placement. This means that when positioning a symbol its placement can then be restricted to 
required area – for example a frame attached jogger can’t be placed on a bar.  

 

Fig 33 Frame Components 

 
 
 
 
 
 
 
 
 



 Version: 1 | 27/02/2014 Arden Software Ltd 
 

 What's New in Impact 2014 Page 24 | 48 
 

Flat top and grid lower unit support 

The lower blanking unit now has the option to create a flat top (typically from wood or steel) as well as 
the standard frame and bar unit.  
 

 

Fig 34 Flat top Lower Blanking Unit 

The offsets can be created offset from the designs with enhanced editing tools and quick replication.  It 
also possible to create a combination flattop and bar blanker lower unit. 
 

Upper blanking unit 

The upper pressers can be created offsetting from the one-up profile, with enhanced editing tools and 
quick replication of the pressers (relative to the one-up designs). 
 

 

Fig 35 Upper Presser Offset and Editing 

 
The rubber profiles for the upper pressers can automatically be generated, where the profile is created 
in a block (for ease of replication). 
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Drawing & Editing Tools 

View Previous/View Next (View Menu/Pan and Zoom/Stripper Creator) 

The View Next and View Previous functions have been expanded.  Upon activation, the tools offer edit-
bar options to jump quickly to various geometric items within the current drawing layer.  These include 
Blocks, Designs, Holes, Stripper Clashes, Stripper Regions, Symbols & Tool Markers: 
 

  

Fig 36 – Edit Bar options for View Next/Previous tools 

Once an option has been selected, further options may be displayed on the Edit Bar (such as Recurse 
into sub-blocks, Block Names etc).  The expanded tools have also been added directly to the Pan and 
Zoom Standard Toolbox and the Stripper Creator tool. 

Pan and Zoom Standard Toolbox – Guidelines 

When the Pan & Zoom Standard Toolbox uses a very high zoom factor, it can be difficult to locate the 
zoomed area (because the shaded rectangle representing the drawing canvas is so small). Optional 
markers (named Guidelines) have now been added, to help users locate the viewed area.  The lines may 
be activated/deactivated via a context menu option (simply named Guidelines). 
 

 

   Fig 37 – Pan and Zoom Guidelines and View Previous/Next Tools 

 
As is to be expected, the colour for the Guidelines is user-definable via 
(Options>Environment>Environment>Colours>General>Pan & Zoom Box).   Additionally, View (Selected) 
Extents, View Next and View Previous functions have been added, as mentioned above.   
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More Interactive Tools – Line Perpendicular Offset 

The Draw>Line>Perpendicular Offset tool has been enhanced by the addition of an Interactive mode, 
which allows the user to check the line-length details on the cursor. 

Favourite Symbols/Design Components 

Following on from the Favourite Standards developments for Impact 2013, a similar mechanism has 
been deployed to allow Favourite Symbols.  This functionality applies to both Symbols and Design 
Components.  The Add to Favourites option is available when inserting Symbols or Components via the 
Block>Insert tool (whether or not the Use Browser to Select Symbols option is enabled) and also via the 
Design Component Library. This development significantly reduces the time taken to insert oft-used 
symbols & components.  As expected, once a symbol has been designated a Favourite, the Add to 
Favourites status will switch to offer Remove from Favourites. 

 

Fig 38 – Add to Favourites (Symbols) 
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 Fig 39 – Add to Favourites (Design Component Library)  

 

Leave Original option Hotkey for Select & Drag tool* 

A new Edit Bar option (Leave Original) has been added to the Select & Drag tool.  When dragging 
selected entities (using the central (triangular) node), this option will leave the original entity in place 
and create a copy, which increases the flexibility of the Select & Drag tool.   
 

 
 

Fig 40 – Edit Bar option for Select & Drag – Leave Original 

 
As it is expected that most uses will be using Select & Drag as their default tool, it should prove to be a 
time-saver in that it is a viable (and quicker) alternative to the Transform Drag tool.   
 
Furthermore, a keyboard shortcut may be assigned to this option to toggle the Leave Original 
functionality on/off quickly.  The shortcut may be found within the General Tools category of the Impact 
Options and is named Edit Bar Toggle Leave Original. 

New View Extents option in Block Inspector 

 

 

Fig 41 – View Next item within the Block Inspector 

 

View Extents has been added to the Block Inspector 
Context Menu.  This tool will benefit users who 
routinely make use of blocks within their projects  
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New Explode option for Arcs to Smaller Arcs 

To aid the cutting of steel waste areas, Arcs may now be exploded into Arc Segments and Quad 
Segments (as well as Lines).  If Arc Segments are specified, a maximum number of segments & tolerance 
may also be specified. 

Support for Open Type Fonts 

Open Type Fonts bring a larger character set and improved cross-platform compatibility.  Both True Type 
Open Type and PostScript Open Type font categories are supported. Type 1 and Raster fonts are 
currently not supported.  Open Type fonts are signified by a new O icon alongside the font name. 
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Enterprise 

Enterprise 2.0* 

It is strongly recommended that all Enterprise users upgrading to Impact 2014 should also be upgraded 
to Enterprise 2.0. Please see “What’s New in Enterprise 2.0” for a description of the new features. Note 
that Enterprise 2.0 is not compatible with Impact 2010 or Impact 2013.  

Database Structure Changes 

It is now possible to publish virtually all Database Installation settings from the central database to sites. 
Publishing installation options is not automatic - it must be performed manually, using Tools > 
Enterprise > Publish Installation Options to Sites from the Database Administration tool. From here you 
can select the options that you want to transmit. You can also view/print a report showing all the 
options that you are publishing. 
 

 

Fig 42 – Publishing Database Installation Options from Enterprise 



 Version: 1 | 27/02/2014 Arden Software Ltd 
 

 What's New in Impact 2014 Page 30 | 48 
 

Graphics 

Semi Transparent Graphics (improved geometry visibility) 

 

Fig 43 – Transparency slider within the Entity Inspector 

ArtTrace Modifications 

  

Fig 44 – Zoom Box tool within Art Trace 

Transparency may now be added to 
artwork and filled areas, to aid the 
visibility of underlying geometry.  
 
 A slider has been added to the 
Entity Inspector to allow various 
degrees of transparency to be 
applied quickly & easily to suitable 
(selected) entities.   
 

The View Zoom Box 
icon within the 
ArtTrace tool has 
now been enabled.  
This allows a 
quicker zoom to 
areas of interest.   
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Layouts 

Composite Layout Creator 

A new Layout tool has been developed for Impact 2014 – Composite Layout Creator.  The tool utilises 
the existing Layout Sheet Assistant and Layout Creator components but with several modifications 
specifically aimed at composite layout creation.   
 
The existing Layout Creator defaults to fill-sheet mode (filling the sheet with the current One_Up layer) 
upon startup.  The Composite Layout Creator suppresses this behaviour – and provides an empty sheet 
upon startup.  Creators of composites no longer have to begin by removing the contents of the filled 
sheet provided by the Layout Creator. 
 
Furthermore, the Composite Layout Creator displays the Add Design Components to Layout dialog 
straight away – allowing users to begin adding designs to the layout, ‘right out of the box’.  Users don’t 
need to locate the All Design Components roll-up to start adding designs to the layout. 
 

Layout Enhancements 

Many new additions have been made to the Impact 2014 Layout Creator – including only checking for 
overlaps when the layout creator is closed and only fixing them if explicitly requested (via Layout>Check 
overlaps).  This prevents the unwanted/unexpected movement of designs within the tool.  The 
undo/redo functionality has been extended to include many additional actions (such as Check Overlaps). 
The placement of components has been significantly improved via the new placement options - you can 
now specify the number of components at the time of placement. 
 

 

Fig 45 – New Component Placement options 
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Composite Component Placement 

The Composite placement option allows you to specify a number of components to place, plus the 
required Layout Pattern.  You can use the keyboard to type a number of designs or use Ctrl + click & 
drag to quickly create a number in X & number in Y placement.  Move the cursor in the x-axis to change 
the number of designs in X, and move the cursor in the y-axis to change the number of designs in Y. 

 

Fig 46 –Composite Placement options 

 

Drag & Drop Component Placement 

Drag & drop placement now displays the component at the cursor – improving performance. 
 

  

Fig 47 – Drag & drop component placement in Impact 2013 (left) and Impact 2014 (right) 

Hotkeys & Shortcuts 

Hotkeys have been improved. The Delete key will remove placements - and so the Remove Selected tool 
has been removed from the context menu. The Nudge functionality (cursor keys/Shift + cursor/Alt + 
cursor) has now been added to the Layout Creator (for both standard & composite layouts). 
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Machine/Sheet Utilisation 

The Utilisation Panel has been reworked in order to be less confusing. Simply click the panel to toggle 
between Utilisation and Scrap/Waste. 

 

Fig 48 –Utilisation panel for Scrap/Waste 

 

 
 

Fig 49 –Utilisation panel for Utilisation 

Colour Options for Layouts 

Several new Layout Colour options have been added to Environment>Colours>Layouts (including 
Utilisation & Waste colours) 
 

 

Fig 50 – New Layout Colour options  

 

 

 
 
 
 
 



 Version: 1 | 27/02/2014 Arden Software Ltd 
 

 What's New in Impact 2014 Page 34 | 48 
 

 

Sheet Layout Estimation Feature 

It’s now possible to generate many of the statistics for a layout without actually generating the layout.  
A new button has been added to the Layout Sheet Assistant (Show Utilisation).  This allows the 
calculation of Machine & Sheet Utilisation, Sheet Area, Knife-to-Knife, Number_Up, Total Sheets, Total 
Over-Produced and Time for a layout, based upon Design, Machine/Sheet Size, Layout Pattern and Run 
Length. Additionally, the Show Utilisation option also allows the filtering of machines based upon 
Largest Number_Up, Least Wasteful and Quickest machines. 
 

 
 

Fig 51 – Utilisation panel & option within the Layout Sheet Assistant 

 

 
 

Fig 52 – Additional filters within the Layout Sheet Assistant 
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Layout Estimator Plugin * 

An Impact plugin has been made available to assist with layout estimation (again, without the creation 
of the layout).  This is the first IAP to be made available for Impact.  The plugin generates all layout stats 
(including number across/down and run waste calculations) for selected design/machine/layout pattern 
combinations.  The plugin also provides an optional preview of each layout.    
 

 

Fig 53 – Layout Estimator plugin 

 

Master Tool Settings 

Favourite Master Tool Settings 

Following on from the Favourite Symbols development, the Favourite concept has been expanded to 
apply to all Master Tool Settings.  Where Master Tool Settings may be selected (in dedicated forms such 
as Layout Sheet Assistant, Plot etc), or via a drop-down list on the Edit Bar, the Add to Favourites and 
Remove from Favourites icons will be displayed. This should make it quicker to select oft-used Master 
Tool Settings.  
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Fig 54 – Favourite Master Tool Settings within Standards Wizard 

 
 

 

Fig 55 – Favourite Master Tool Settings within Layout Sheet Assistant 

 

Output 

 
Extended Plotter/Post Processor Substitution Codes to access any database 
field* 

Additional plotter substitution codes are available in Impact 2014, allowing the user to output any 
database field in NC-code using the syntax %<DBF:TABLENAME.FIELDNAME> 
 
As an example %<DBF:DRAWINGS.D_KEY> would insert the D_KEY value from the DRAWINGS table for 
the current drawing. 
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Similarly, %<DBF:CUSTOMER.CS_NAME> would insert the CS_NAME value from the CUSTOMER table, 
for the current drawing. 
 
And %<DBF:LAYERS.L_SHELLRAD> would insert the value of the SHELLRAD field from the LAYERS table 
for the current drawing layer. 
 
This new feature works seamlessly with existing substitution codes for Drawing name, Layer name and 
Overall drawing size.  This can be especially useful for CNC machines where job specific information is 
required for the front-end controller. 
 

Post Processor Pocketing Options* 

Impact 2014 sees the introduction of the new Post Processor pocketing option - ‘Pocket all entities 
separately’ ideal for when cutting both wood and steel. This new function prohibits the build-up of 
waste in slotted areas by optimising the output so that each entity is cut separately.  This results in a 
higher quality manufactured finish and reduces the likelihood of damage to the CNC machine’s tool 
head. 
 

 

    Fig 56 – New Post Processor Pocketing Option 

 

Import/Export 

Support for Autocad 2013 DXF & DWG file Import  

A 3rd party library update allows Impact to expand support up to and including the ‘2013’ versions of the 
*.dxf and *.dwg file formats.   

Support for Autocad DWG Export * 

This functionality is linked directly to the Collada 3D and AutoCAD DWG 3D developments.  Impact now 
provides support for the 2004/2007/2010 & 2013 versions of the *.dwg file format. The exact version of 
the format maybe selected from a drop-down list within the Autocad Drawing node of an Import/Export 
Master Tool Setting. 
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Note that DWG exports from an Impact 3D layer will be exported in the Autocad 2013 version of the 
DWG format, regardless of the DWG version specified in the export setting. 

    Fig 57 – Autocad Drawing (*.dwg) export configuration within Master Tool Settings 

Tool 

Imperial/Metric Toggle (without changing Appearance Settings)* 

A new tool has been added to aid users needing to switch between Metric & Imperial units regularly. 
The tool is named Toggle Measurement Unit and is available via Customise mode (Options tools) – 
simply drag & drop the tool onto a menu or toolbar to make it visible.  
 

 
 

Fig 58 – Toggle Measurement Unit tool 
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Because this is an actual Impact tool, it’s also possible to assign a keyboard shortcut to the tool.  You can 
find the shortcut assignment via Customise Mode, within the Option Tools category on the Commands 
tab. You can also find the tool via Options > Environment > Environment > Keyboard > Option Tools.   
 
 
If Rulers are being displayed, you can also double-click at the intersection between the rulers to switch 
units.  This is perhaps the quickest & most intuitive use of the new tool.   
 
 

            
 

Fig 59 – Toggle Measurement Unit – within Rulers 

 
Please note that this tool does require users to have the Settings privilege (found within the 
Environment folder of a User Privileges Master Tool Setting) to be enabled. 

Impact Viewer 

Hiding Files/Database Navigation Panes* 

The (Stand-Alone) Impact Viewer can now accept a range of command-line arguments: 
 
ImpactBrowser.exe -[fpstkcnl] parameter 
 
Where 
 
f = specifying a filename 
p = specifying a project 
s = specifying a standard 
t = specifying a template 
k = specifying item using a key 
n = specifying item using a name 
c = specifying item using a code 
l = specifying a layer 
 
The viewer will then launch and display the relevant drawing/layer but the navigation panels will be 
hidden.  Effectively this presents the Viewer as a stripped-down Information Pane with the Preview 
enabled. 
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Working Environment 

‘Apply’ Button added to Options>Environment 

The presence of an Apply button allows the user to preview certain environment changes, before 
accepting them.  This is perhaps most noticeable when making changes to Impact colour such as the 
Project Background (Options>Environment>Environment>Colours>Drawing>Project Background). 

New option for Selection Cursor (Arrow)* 

For new users, Impact’s default cursor may be quite confusing – especially when used for relatively 
simple operation such as entity selection.  A new Environment option has been added - Show crosshair 
when selecting entities to help with this issue.  When enabled, users will see the traditional Impact Entity 
cursor.  When disabled, a much simplified cursor (resembling the Windows Normal select pointer) will 
be displayed.  As soon as a drawing (or other) tool is activated, the traditional Impact cursor will be 
displayed. 
 
 
 
 
 

 

Fig 60 – Simple and default selection cursors  

 

Convert a Layer Insert into a Block Insert 

In certain circumstances, it may be desirable to convert a Layer Insert into a Block Insert.   

 
Hotkey to toggle Visibility of Drag Handles* 

Impact’s Drag Handles are very powerful & useful.  However, in certain circumstances (such as many 
selected entities within a small area), they can hamper entity visibility & general usability. In these 
circumstances, the ability to toggle the Drag Handles on & off quickly can be advantageous.  The existing 
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edit-bar tick-box has been augmented by a user definable keyboard shortcut, to make the toggling of 
Drag Handles quicker & easier.  The shortcut may be assigned via the General Tools category of the 
Impact Options dialog, and is named Edit Bar Toggle Drag Handles. 

Icons for Options Environment 

Impact 2014 now has a full set of icons for the various nodes found within Options>Environment 
(Database Installation, Database Operation, Environment, Standards & Workstation). 
 

   
 

Fig 61 – Complete Environment icons 

 
 
 

  

Fig 62 – Complete Environment icons - continued 
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Multilingual Settings* 

Certain items in the database may now be translated to aid any users who do not speak your company's 
primary language. This can be particularly useful for Enterprise users, where there might be multiple 
databases running in several countries. Items which may be translated include: Master Tool Setting 
names, Symbol names, Folder names, and Descriptions.  
 

 
 

Fig 63 – Multilingual Settings – String Translation dialog 

 
Using this mechanism, for example when inserting a symbol into a drawing, each user will see the 
symbol names in their own language.  
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Print-Face/Die-Face Simplification* 

For users who do not need define different faces/sides of a drawing, simplified terminology has been 
introduced (whilst previous functionality has been retained). 
 

 

Fig 64 – Simplified Orientation Terminology options 

 

Additionally, the Utilities > Face Setting dialog has been modified to reflect these changes. 
 

 
 

Fig 65 – Simplified Face Settings dialog 

 
 
The Actual View (a.k.a. Dieside with the new simplified terminology) can now be set to Undecided and 
thereby reducing the sometimes confusing options of “actual view” and “viewed as” view. 
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If enabled, the Undecided setting will simplify all input/output dialogs (Import/Export, Plot etc) by 
removing the superfluous options. 
 

 

Fig 66 – Simplified Face options in the Export dialog 

Denote Current Appearance Setting 

Many users create/use multiple Appearance Settings (eg dedicated screen layouts for 2D design work, 
3D animation etc).  In Impact 2014, a tick will be placed by the currently-loaded Appearance Setting, 
within the Appearance menu, so at any point, the user will be sure which setting they are currently 
using.  This can be especially useful when settings are about to be modified/over-written. 

 
Fig 67 – Current Appearance Settings hint 



 Version: 1 | 27/02/2014 Arden Software Ltd 
 

 What's New in Impact 2014 Page 45 | 48 
 

Enhanced Layer Properties – Session Information 

Tools such as the Parametric Editor, Stripper Creator and Layout Creator store ‘session’ information 
within an Impact drawing.  Users can therefore create a partial stripper, parametric model or layout, 
quit the tool and then return to the tool at a later date to ‘carry on where they left off’.  This session 
data is therefore extremely useful - but it will contribute to overall file size, and there may be 
circumstances in which people may wish to ‘start from scratch’.   
 
New layer status icons indicate whether a drawing layer has stored parametric, stripper or layout session 
data and allows that data to be purged (if required).  The new icons are found within the General tab of 
the Layer Properties dialog box. 
 

 
 

 

 
 
 

     

                                       

Fig 68 – Session Information icons 
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Clicking the icons will display the following message: 
 

 

Fig 69 – Purging Session Information  

At this point, any saved Parametric/Layout/Stripper session information will be removed for the drawing 
– keeping file size to a minimum but also allowing the user to ‘start from scratch’ as mentioned above. 
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